
INTRODUCTION

A person who was good at performing numerical calculations was called a human
computer much before computers came into being. The use of mechanical
calculatingdevicesmadehistasklessdemanding.Theuseofpunchedpapercards to run
jacquard looms came up around 1800. The development of transistors followed by
microprocessors based on integrated circuits led to the size of the computers
becoming smaller and its price also came down.

Designingwithcomputersiscalledcomputeraideddesigning(CAD)andtextile designing
with computers is called computer aided textile designing (CATD).

Designingwithcomputersofferssomanyadvantagesthatengineers,technologists,
professionals and so many others make use of them in their everyday work. Some
of the major advantages are:
• We cansavealotoftimeand labour.
• Wecanmake designswithverygreataccuracy.
• Wecanmakeanumberofcolourcombinationsofonedesigninaveryshort-time period.
• Wecanmakeverycomplicateddesigns withdifferenttextureandcoloureffect very
easily.

A.TOOLBOX

1. PickTool-Throughthistoolalltypesoftextandobjectscreatedonthe page
are selected and move after selecting the object

2. ShapeTool(F10) usestheshapetooltomakeanytypeofdesigncreated on
the page into another shape. After converting the shape or text to a
curved one, you can use the options like delete ad and curve by right
clicking the mouse.



3. KnifeTool Usesittocutanygraphicsinanyform.
4. EraserTool(X)Usesittoerasethegraphicandconverttocurvedtexton the

page.
5. SmudgeToolAnygraphicandtextisusedtospread with

the help of a brush.
6. RoughenToolItisusedtogiveanyobjectathornyor

toothed design.
FreeTransformToolItisusedtotransformany shape
into another angle.

7. Virtual Segment Delete Through this, we use to
removeanygraphicfromthepageduringselection.

8. ZoomTool(Z)Weusethistoenlargethepage.After
taking this tool,the parton which the draw will take
place will zoom. You can also zoom in and zoom out
by clicking itIfyouclickthe leftmouse button,itwill
zoom out If youclick the right button, it will zoom
out

9. HandTool(H)Itisusedtomove(Resettlement)the
pageas well as zoomin and out Double clicking the
leftbuttonofthemousezoomsin(big)andtherightbuttonisdoubleclick to
zoom out (small).

10.FreeHand tool{F5)throughthistoolyou candrawanytypeoflinedesign in any
angle.

11.BezierToolWiththistool,you candesignanytypeoflinein differentways such
as burning lamp, tree leaves and other shapes.

12.Basics ShapeWith the help of the basic shape, the rectangular triangle
andallothershapesareusedtodraw.Tochangetheshapestyle,youcan draw
by changing the shape by going to the Perfect shape option in the
Properties bar.

13.Artistic Media Tool(I} By this tool Coral is used to draw the default shape and
designindraw,inthisyoucanusedifferenttypesofBrushlike preset, sprayers, such
as calligraphy, and other graphic etc.

14.Pen ToolWiththistool,youcancreateanytypeofdesigninanyangleandmake any
shape with your mouse.

15.PolylineToolThepolylinetoolisalsousedlikeapentoolandyoucanalsouseit like a
free hand tool, both of which are given in the same tool.

16.InteractiveConnectorToolThroughthistool,2objectscreatedonthepageare



usedtoconnectthem together.
17.DimensionToolUseittomeasureanygraphiccreatedonthepage.In this,wecan

measure the object of any angle.
18.SmartDrawingTool(S}throughthisyoucandrawanytypeoflinebydrawing

smooth line and straight line.
19.RectangleTool(F6}Rectangletoolisusedtodrawobjects.Pressingthe Ctrlbutton and

drawing will make your object the same size from all four sides, to create exactly
the right rectangle.

20.3 Point Rectangle Tool It is also used to draw a rectangular object (Rectangle) but
firsta straightlineisdrawninit,afterwhichyourrectanglewillbereadywhenthe mouse
is moved in the other direction.

21.EllipseTool(F7}Itisusedto drawcircularshapes,withthisyoucanmakeshapes like
circles and ovals. Exactly (precisely) to draw Ellipse, pressing the Ctrl button and
drawing will keep your object equal in size from all four sides.

22.GraphPaper(D} Graphsareused toplaceone ormore tablesonapage.
23.Polygon Tool (Y} by this, you can create polygons with different types of arms, if

neededtoreduceorincreasethe arm,youcansetthenumberofpointpolygonsin the
property bar.

24.SpiralTool(A}Used todrawthecurvedLINEthroughit
25.BasicsShapeWiththehelpofthebasicshape,therectangulartriangleandall

othershapesareusedtodraw.To changetheshapestyle,youcandrawby
changingtheshapebygoingtothePerfectshapeoptionintheProperties bar.

26.Arrow Shapes Use the arrow shape to draw an object like arrow. To
changethearrowstyle,youcanchangetheshapeanddrawbygoingto the
Perfect shape option in the Properties bar.

27.FlowchartShapesWiththehelpofflowchart,cylindersareusedtodraw
shapes like triangles etc. To change the style, you can draw by changing
the shape by going to the Perfect shape option in the Properties bar.

28.StarShapesStarslikeshapesareusedtodraw.Tochangethestyle,you can
draw bychanging the shape bygoing to the Perfectshape option in the
Properties bar.

29.Callout ShapesWith the help of its tool, it is used by any person to show
things,it is used more in cartoons. You canalso write information related
tothisshape.Tochangethestyle,youcandrawbychangingtheshapeby going
to the Perfect shape option in the Properties bar.

30.TextTool(FB)Useittowriteanykindoftext,after takingthistoolyoucan write
text even by drawing but after drawing you have to convert to



artistictextwhoseshortcutkeyis(Ctrl+FB).Ifyoudonotwanttoconvert, after
taking this tool, click anywhere on the page and start writing direct. Your
text will already be converted. Font style or related settings will be found
in the properties bar.

31.InteractiveBlendToolThroughthistool,twoobjectsonthepageareused to
blend together. You will find related settings in the Properties bar.

32.InteractiveContourTool Throughthisoptionyouuseanytypeofcircle and
square to givea framing effect.You will find related settings in the
Properties bar.

33.InteractiveDistortionToolUseanyselectedobjecttocreateanopposite
design or shape. You will find related settings in the Properties bar.

34.InteractiveDrop ShadowUsedtoapplyshadowtoanyselectedobjector text.
You will find related settings in the Properties bar.

35.InteractiveEnvelopeToolUsedtoextendandmaintainanycreatedshape or
object in different types of angles. It works just like a Shape tool. If you
selecttheshapeonwhichyouhaveusedthistoolandtaketheshapetool, you
will still get the envelope tool.

36.InteractiveExtrudeTool Useanyobjectortexttomake30,youwillfind
related settings in the Properties bar.

37.InteractiveTransparencyTool Usedtomakeanycolorobjecttransparent. You
will find related settings in the Properties bar.

38.EyeDropToolWiththehelpofthistool,weusetopickthecolorofsome other
object. Which can be filled in other objects with the help of paint bucket.

39.PaintBucketWiththehelpoftheEyeDropTool,oneormoreobjectsuse the
captured color to fill in another object.

40.OutlineTool(F12}Theouterlinesofanyobjectareusedtothinorthicken and fill
color, as well as setting the corner and line caps.

41.FillTool(F11}withthishelp,theselectedtextorobjectisusedtofillthe solid
color.

42.Fountain ColorWith the help of this tool, we use double color for anytext
or object. Going into custom, you can fill many colors simultaneously in
anyobject.Ifyouwantapre-madecolor,youcanselectanycolorbygoing to the
Presets option and you can also change the color as per yourchoice.

43.Interactive Fill Tool Through this tool, any type of color can be filled in any
object,includingfountaincolor,texture,uniformetc.Justlikeyougetwhen



youopenthefilltool,youwillfinditinthefiletypeintheproperties bar.
44.Interactive Mesh Fill Tool It is also used for coloring but in this the color is filled

with the help of grids. To increase the grid reduction, we will customize the grid
size in the Propertiesbar. In this, afterapplying the grid,youcan click anywhere on
theobjecttofillanycolor,whichwillbelikeafountain,theonlydifferenceis thatit has a
grid and it is simple

B.FILEMENU

1. NewThisoptionisused togetanewblankpage.
2. NewFromTemplateThroughthis,weusetotakethedefaulttemplatedesign which

is already given to us in the Corel draw by Corel Company.
3. OpenThisoptionisusedtoopenaCDRfilepreviouslysavedtoaharddisk.
4. ClosethisoptionisusedtocloseActivecurrentpageof CorelDraw.
5. CloseAllThisoptionisusedtocloseallopen pages.
6. Savethisoptionisusedtosave CorelDrawfileinthecomputerHarddisk.
7. SaveAsThroughthis,wesavethealreadysaveddocumentinadifferentnameand can

also be saved in any other format.
8. Revert Through this, after taking the file which we have

alreadycreated,thereissomemistakewhileediting,then use
it again to make it like new.

9. Acquire Image With the help of a camera or scanner,
ACQUIREIMAGEisusedtoinsertanytypeofimagein
Corel Draw.

10.ImportUsesomekindofimageandsomeotherfileto
fetch in CorelDraw.

11.Exportinthisoptionyoucanexportyourgraphicintoany
other format

12. ExportforOfficeThisoptionisusedtoexportyour
graphics into png format and send it to MS off ice.

13. SendtoThefilescreatedthroughthisoptionareusedfor any
other Drive, Mail, Zipped file and fax

14. Prepare for service Bureau This option is mostly used
when sending a design created in Corel Draw from one
server to another. It is used by people whose work is
mostly to design and send online designs. In this, when
yousavethefile,thenyoucansavethepdfinadditionto
cdrandalsowhichfontyouhaveused,thisinformationisalsosaved.Youcanalso



savethe fontifneeded.
15. PublishtotheWebUsedtopublishanydesigninHTMLorFlashfileoninternet.
16. PublishtothePDFItusesanytypeofgraphicstocreate aPDFfile.

C.EDITMENU

1.Undousesthistodoastepbackwards.
2.Redousesittodoastepforward,itonlygoesaheadwhenundoishigh
3.Repeatcanrepeatataskusingit.YoucanalsouseCtrl+R.
4.Cutisusedtocut(transfer)anyselected
graphicsortext.

5. Copyusesthistocopytheselectedtextora
graphic.

6. Pasteisusedtopastecutorcopiedobjectsor
text.

7. PasteSpecialpasteproperlyorproperlywhen
objectsortextcopiedfromanothersoftware
arepastedunder PasteSpecial.

8.Deleteisusedto eraseanyselectedtext or
guides.

9. Symbolusesany graphics on thepageas
symbolstobekeptinaharddiskforever.

10.Duplicateusetocopyanyobject
11.CopyPropertiesfromwithinanyobject
createdthroughit,thefilteredcolorandthe
outlinecolorareusedtofillthesamecoloron the
other object.

12.OverPrintoutItismostlyusedtoprintoutlines
ofanytypeofobjectaccurately.

13..OverPrintFillItisusedtoproperlyprintthecolorfilledin
anyobject.

14.SelectAllusestoselectanytext,object,guides,nudgethroughit.
15.FindandReplaceuseittosearchforagraphicortextafterconverting.
16.InsertBarcodeisusedforinsertinganytypeofbarcodethroughit.
17.InsertNewObjectis usedtodrawfiles from anyothersoftwarein

CorelDraw and after creation.



18.ObjectWhenaPDFfileisimportedintoCorelDrawthenitshowsthe
option.Thisoption containsalink thatwillopenfromyourPDF Acrobator
throughsoftwarethatwillbeinstalledinyourcomputer.

19. Links..
20.PropertiesusetobringDockerthroughitwhichisrelatedtothefeel,
outline, andlink.

D.VIEW

1. SimpleWireframe/WireFrameUsedtodisplaytheoutlineofagraph
drawn onany pixel

2. Draft/Normal/EnhancedUsedtodisplayanygraphcreatedonapixelin
actualform.

3. FullScreenPreview(F9}throughthis,all
graphicscreatedonthepageareusedtoviewin
fullscreenmode.

4. PreviewSelectedOnlyThroughthis,weuseonly
toviewtheselectedobject infull screenmode.

5. PageSorterViewUsedtodisplayallinserted
pagesinthe samewindow.

6. RulersItisusedtohideandshowtheruler.
7. GridItisusedtohideandshowthegrid.
8. Guidelineitisusedtohideandshowthe

guideline.
9. Show Inthis,youwillfindoptions related tothe

pageinwhichsettingsrelatedtotheborder,
bleed,printablearea,etc.ofthepagewillbe
found.

10.EnableRolloverUsedtoturnonrollover.
11.SnaptoGrid/SnaptoGuidelines/Snapto

Object/DynamicGuidesItisusedtoturnall
theseoptionsonandoff.Its functionisusedtosee
itsanglepointwhiledrawinganyobject.Itonly
appearswhenanobjectorlineisdrawn.

12.Grid and Ruler Setup/Guidelines Setup/Snap to Objects
Setup/DynamicGuides Setup Allthese are used to changethesettings.



E.LAYOUT

1. InsertPageItusestoinsertmorethanonepage.
2. Delete Page Useto delete a page that has been

inserted.
3. Rename Page By this,weuse to rename a page and

writethe nameof thepage.
4. GoToPageLet'suseittogotoapage.Itismostly

usedtovisitasinglepagewhentherearemore
pages.

5. SwitchPageOrientationUsingit,youcanmakethepagePortraitorlandscape.
6. PageSetupUsingthisoptionwecaneditpagesizes.

F.ARRANGE

1.TransformationThepositionsizeofanyobjectcangivetheeffectofangleandallother
things,that is,it cansetitsrotationaccordingto itself

2. ClearTransformation Useto eradicatethe effect appliedwiththe helpof
transformation

3. Align and Distribute Used toset any objectfrom another object to the leftright
centerandotherdistributes

Ifafterselectinganytwoobjects,whatwillworkonpressingthebuttonaccordingto the
image below is written in the left side.

Note- If you want to use for an object, then first
select the object you want to Align, then select
thesecondobjectwiththeShiftbuttonbetween
which to Align, then use the shortcut keys.

4. Orderwiththehelpofthisoption,youcansetyourselectedobjectupanddown and
can be read in detail below-

 ToFrontUsed totopthe selectedobjectfromallthe objectsatonce.



 ToBackUsedtolowerthe selectedobjectfrom allthe objectsatonce.
 Forward OneTheselectedobjectisusedtotopalltheobjectsonebyone.
 BackOneUsedtolowertheselectedobjectfromalltheobjectsoneby one.
 InFrontofUsetheselectedobjecttomoveaboveanyotherobject.Assoonasyou select

this option, your cursor will become an arrow and your object will be above the
object you click that arrow.

 Behind Itisalsolikethe in frontofmentionedabovebutitisusedtorearan object.
 Reverse Reverse means that like you have drawn 5

objects which have been drawn first, it will be at the
bottomassoonasyouselecteveryoneandreverseit will
just reverse.

5. CombineUsedtocombineoneormoreobjectsin
parallel

6. BreakApartusedtoun-combineacombinedobject.
7. LockObjectUsedtolockanyobject,itkeepsthat

object in its place.
8. UnlockUsedtounlockalockedobject.Youcanalso

unlock it by pressing the right button of the mouse
and clicking on the unlock option.

9. ConverttoCurveafterusingrectangular,circleandall otherobjectstoconvert them
to curve, it is used to create different design with shape tool.

10. ConvertOutlinetoobjectAfterbreakingtheoutlineofanyobject,usetheoutline to use
it as an object.

11. ClosePath Tomakeadrawnlineacompleteline,we useaclosedpath.Sothatthe two
ends of the line join together. Or you can also say that after drawing a single line,
you can use it as an object



G.EFFECT
1. Adjustjpg,jpeg,png,bmpandothersusevarioustypesofeffectsonimagefiles like

contrast, enhanced, Tone Curve Colors balance Hue saturation
2. Transform Inthisalso,coloreffectsonanyPngandJPGfilesareusedtocolorthe

opposite.
 Delnterlace (lets you remove lines from scanned or interlaced images) Sometimes

while scanning an image, the effect starts coming like a lining, using the same line
toremoveitwiththehelpofit,althoughmoreorlessitbecomesamildmesh.You can set
it according to the odd and even line.

 InvertUse ittoopposite the colorofyourimage,youcanalsocallitnegative.
 Posterizeletsyoureducethenumberoftonalvaluesinanimage.Posterize

removes gradations and creates larger areas of flat
color.

3. CorrectionUsedtoreducescratchesanddustonany
Bmp, Jpg, Png file.

4. ArtisticMediaArtisticmediaisusedtosetthebrush,as soon
as you take a shape, the artistic brush will immediately
turn into Artistic and you will see the last used brush at
the top as soon as you open it.

5. Blend Use of it has been told in the tool box itself,
however, if you open from here, a docker will open in
whichyoucanblendaccordingtothenumberofsteps.

6. ContourItsusehasalsobeenmentionedinthetoolbox, on
opening it, the docker will open in which after selecting
To Center, Inside, Outside, you write to keep the offset
in inches, and other steps in it, the layer you need It is
written as it is. If you want to use it without this docker,
after selecting it from your tool box, after goingtothe
propertybarandsetting a point,the object on which you
drag it will come with a Framing Effect.

7. Envelope like Blend, Contour mentioned above, it will also open in this, after
selecting any object you have to use it like a Shape tool, but if you are using
Docker.ThenyouwillgettheoptionofAddNewandAddPresetinwhichyoucan create
your own shape with the help of Add New and using the pre-made shape with
the help ofAdd Preset. Whichthe company keepsadding to itatthe time of
software development.



8. Extrude It has been told to you in the tool box that if you want to use from here,
on opening, a docker will open in which after selecting the object or text, you can
click on the edit button and apply the vanishing point by applying the 3D effect.
Andyoucanalsoseeitspreview.Afterapplyingalltheeffects,theeffectisapplied to the
text or object.

9. Lensitisusedasallayerthatshowsthetrailingobjectortextineffectwhileany trailing
object makes a difference. As soon as Frozen is clicked, it is copied and added
tothe layeraboveit.Whichyoucanre-groupandaddyoureffectorany color. In this,
you will get a lot of effects, whose name is- Brighten, Color
Add,ColorLimitCustomColorMap,FishEye,HeatMap,Invert,Magnify,Tinted Gray
Scale, Transparency, Wire Frame. Click here to see all the effects

10.AddPerspectiveItisusedonconvertedartistictext.Byapplyingitonanyshape,it feels
like it is stuck. While using it, you will see four nudges in which you use to apply it
according to the shape.

11.Power Clip inside It is used to place text or photos inside any shape. You can also
drag itwith the right button of the mouse, in thisyou will get the power clip inside
which is used for most images. If you want to use any change in the image after
applyingittoreducethesize,thenright-clickonit,aftereditingthecontent,adjust the
image and right-click again and click on Finish Editing. Or click on the power
clipped image with Ctrl After editing, click on any empty part of the page with Ctrl

12.Add Rollover with this help, we use to add hyperlinks to any object. Which you
havetousewhilestayinginthecoraldraw.Afterapplyingit,youhavetorightclick and
click on Jump to Hyperlink in Browser, which will open the hyperlink you have
added to the Internet Explorer.

13.ClearEffectUsedtoremovetheeffectapplied.
14.CopyEffect/CloneEffectWiththehelpofthesetwo,weusetheeffecttocopy.Itis used by

taking a simple shape and if you select the shape with the effect applied and go to
this option, then it will look like a head. Just like you have taken two
objectsandhave written some text forboth,give a Perspective effectonone while
nothing on the other. Now you can click on the simple text and select that text by
clicking on the perspective from the copy effect from the effect menu. If you click
on the effect, as soon as you click, your simple text will also be changed to the
same effect as before.

H.BITMAPS
Inthis,afterconvertinganygraphicstobitmap,youcangivemanyeffectsasinthe image
above. And yes it does not work until we convert a graphic. Either we



convertthegraphicortakeajpg,png,bmp,imageonlythenwecanuseallthe effects of
this menu.
Note-:Useitbyyourselfsothatyoucanunderstanditseffect.Stillgivingsome options
here.

1. Convert to Bitmap with its help, you can use any graphic created
afterconvertingittoabitmap.Andunlessagraphicisconvertedto a
bitmap, you cannot use the option of the Bitmaps menu

2. EditBitmapWiththishelp,theconvertedbitmapisusedtoedit with
the help of Corel Photo Paint.

3. CropBitmapwiththishelpyoucancropabitmappicture.
4. TraceBitmap Withthehelpofthisoption,anyimagefileisusedto

create a softcopyof Corel Draw bytracing the help image of Corel
Trace software. After trace, you can make any changes in it.

5. ResampleWith the help of this option, any bitmap is used to
increasetheresolutionofanyimagefile.Note:Keepinmindthat only
the pixel will decrease and the image size will not increase.

6. ModeUsetosetthemodeinwhichyouwanttoputyourbitmap file.
7. InflateBitmapwithitshelp,bitmapsareusedtoincreasethe

pixels of the image.
8. Bitmap ColorMask withthishelp,weremoveasinglebackgroundanduseittomake

Transparent.
Nowyoucanusealltheoptionsafterthisby yourselfbecausenowtheoptionswith effects
are left.

I.TEXT
1. FormatTextItismostlyusedtocreate selectedtextorparagraphsinstyleandmodel.
2. EditTextUse toeditcertainlettersortextinanytextorparagraphwritten.
3. InsertCharacterUseanytypeofoutlinewordora symbolto insert.
4. FitTextto Path Itusesthe objecttoplacethe converted textonanyobjectonIthe

object'soutline,ordragandholdthetextontheobjectwiththerightbuttonof the mouse
and then release the mouse,an option opens.Inwhichyoucanapply textby selecting
Fit Text to Path.

5. FitTexttoFrameanyparagraphsthatarenotconvertedtoartisticareusedtofit their
text frame, which automatically sets the font size.

6. AligntoBaselineanyparagraph,wordisusedbelowtheshapetooltosetitina line.



7. StraightenTextIfanyparagraph,wordisslantedwiththeshapetool,thenuseit to
straighten it.

8. Writingtoolwiththehelpofitsoption,youuseanyparagraphtowriteit
accurately and set the spelling as a whole.

9. EncodeWiththehelpofthisoption,youcanuseittochangetheencodingofthe typed
text, but keep in mind that when you use this option, then you will select
another font then there is little chance of changing the font style.

10.ChangeCaseThroughthisoption,youcanchangethecaseofwrittentextin which
Sentence case, lowercase, UPPERCASE, Title Case, tOGGLE cASE.

11.WebtextCompatibleWhenyouselectthisoption,youcanchangethetextstyle in
HTML to publish to the Web document.

12.Convert to Artistic Text Through this, the text
written in the text frame is used to convert it into
artistictextwhichyoucanthenresizeaccordingto
your own.

13.Text Statistics Through this option, you can see how
many words have been written in your entire page,
whichfonthasbeenwrittenfromit,youcanalsosee the
artistic text in it.

14.ShowNon-PrintingCharacterSelectinganytextand
clicking on this option will show you the character
that will not print, such as space and inter (change
paragraph).

15.Link\ Unlink Use to convert and break one or more text boxes into a single box,
or drag the text to another text box by pressing and dragging it with the right
buttonofthemouse,thenreleasingthemousewillopenan optioninwhichYou can
keep the text according to yourself



J.TOOLS
1. Options / Customization Use these two to change the settings, commands, etc.

inthesoftware.Andthroughthisyoucanalsoassignyourcommandtorunfrom
shortcut key.

2. ColorManagementThroughthiscolorsaremanagedandcolorcanbeselected
according to the quality.RGB, HSB, CMYK are the main ones.

3. SaveSettingsasDefaultItisusedtochangethechangedsettingsinthe
software as before.
Note Save Settings as default followed by 7
optionswhichareObjectManager,ObjectData
Manager, View Manager, Link Manager, Undo
Docker, Internet Bookmarks Manager, Color
Style. All these are used to bring Docker. And
after bringing Docker you can control the tools
and settings.

4. Palette Editor Through this, you use to change
thecolorinCorelDrawandwiththisyoucanset the
preset as well.

5. GraphicandTextStylesItisusedfortextstyle.In
this,youhavetoapplythesettingsafterselecting the
text. Similarly, we can apply any object.

6. Scrapbook Through this, you use to insert any
clipartandinsertanyclipartthroughtheInternet.

7. Create Inside it you will find 3 options Arrow, Character, Pattern, all three are
used separately. Arrow uses any shape drawn on the page through it to create
anarrow.Youhavetouseitinanarrowoptioninastraightlineorsmoothline.
Character also has the same function as Arrow but it will only apply to the font
you have created.

8. RunScriptItisusedforscriptcodethatisrelated tobinarysystems.
9. Visual Basic Visual Basic thisisa small VBS software thatisvery useful,you also

get it in MS Office. It is used in theDeveloper menu to record the current work,
assoonasyoustarttherecordthis VBAprogram.Itwillrunandisrecordingthe
command you are doing, after all the work is done you have to stop by clicking
the stop button again. If you want to run and then you have to go to play and



selectyourrecordedmacroandpresstherunbutton,assoonasyoupressthe button
your graphic will be created by taking a small load.
NoteVBAislikeacommandwhichhasadifferentcode.Themacroyourecordis recorded as a
code as you can see in the image below.



K.WINDOW
1. NewWindowItisusedtouseanexistingpageintwowindows.Bydoingthis, nothing

is deleted from the page but both remain the same.
2. Cascade/Tile horizontally/Tile Vertically
These three are used to view one or more
Pages,inwhichyouwillgettoseedifferent
previews of all three.

3. ArrangeIcons
4. ColorPalettesItisusedtoaddorreplacea

color box.
5. Dockers UsetofetchandremoveanyDocker.
6. ToolbarsUseanytooltofetchandhide.For this,

you can also use this option by right clicking
on the menu bar or status bar.

7. CloseUsetoclosethecurrentlyopened page.
8. CloseAllItisusedtoclosealltheopenpages in

Corel Draw.
9. RefreshWindowitisusedtorefreshtheCorel Draw.



INTRODUCTION
AdobePhotoshopisagraphics-editingprogramPhotoshopisusedforcreatingand
editing images for printing and for web development Photoshop is equipped with
high-quality features which are easy is use. Many version of adobe application are
introduce byAdobeSystemsIncorporated Now Adobe Photoshop CS. Thus,Adobe
Photoshop CS5 is the 12th major release of Adobe Photoshop

FEATURES
Photoshop is equipped with high-quality features and with help of these features
we can enhance our images for example provide various Filter effect which are
apply with some click also provide blending mode which can help blend different
layers Photoshop uses more than one color models like that RGB, lab, CMYK,
grayscale,binarybitmap,andduotonewhichcanhelpindevelopingtheimagesfor
printing andforweb.Photoshophasthe abilitytoreadandwrite raster andvector
image formats such as .EPS, .PNG, .GIF, and .JPEG. Photoshop has ties with other
Adobe software for media editing, animation, and authoring the advanced Adobe
version also provide sport to windows touch devices. A number of UI
improvements make the Fill dialog more intuitive and easier to use.

ElementsoftheAdobePhotoshopWorkspace
(Interface)
InAdobePhotoshopwecancreateandmanipulatethedocumentsandfilesusing various
elements, such as panels, bars, and windows .Any arrangement of these elements
is called a workspace.
TheseelementsalsoreferasElementsofAdobePhotoshopInterface.Following are
the elements of Adobe Photoshop Workspace

1. The MenuBar
2. TheOptionsBar
3. The Toolbar
4. The Palettes
5. TheDocumentWindow
6. TheActiveImageArea



1. MenuBar:-
ThemenubarisorganizedintospecificcategoriesoftasksforexampleFile,Edit,
Image,Layersetc.Menusareprobably the mostfamiliarinterface elementstoa new
Photoshop user. They contain all sorts of options
2. OptionBar:-
The option s bar contains options for the specific tool we have selected in the
toolbar. The options bar locateddirectly underneath the menus. Option bar is a
usefultoolwhenworkingwiththedifferentPhotoshoptools...Whenyouswitch from
one tools to other these options change
3. TheToolbar: -
Most important element of the Photoshop interface is the toolbar. It contains a
bunch of icons that represent the different tools Photoshop offers to alter and
createimagestheseincludetoolsforselectingspecificareasofimages,changing the
colors of the image, stretching, transforming, and erasing parts of an image, and
many more.
4. ThePalettesorPanes:-
Thepalettesallowustomodifyandmonitorwhatweare workingon.

 TheNavigatorPalette
Usedfornavigatinglargeimagesornavigatingimageswhenzoomedin.TheColor Palette
Allowsustoselectforegroundandbackgroundcolors.Whilewecanalsodothis within
the toolbar this palette offers greater options

 TheHistoryPalette
Allowsustoreversechangeswehave madetoourimageitcontainsalistthatis constantly
updated of changes made inside the document.
TheLayersPaletteAllowyoutoworkonasinglecanvas.Allowingsomethingsto appear
above and below others.
5. TheDocument Window:-
Thewindowthatcontainsthe imageweareworkingon.
6. TheActiveImageArea

HowweCustomizetheWorkspacesinAdobe
Photoshop?
InAdobePhotoshopwecancreateandmanipulatethedocumentsandfilesusing various
elements, such as panels, bars, and windows. Any arrangement of these elements
is called a workspace in photo shop when we work then if we want to



placetheentireelementinphotoshopinterfacethenthisprocessiscalled customization
of photo shop interface.
StepforCustomizationofWorkspace:
FirstofAllarrangethedifferentelementyoucanplaceanyelementanywhereyou want
with mouse dragging. And open or close any element form windows menu.
Forthispurposeopenwindowmenuandticktheelementwhichyouwantto display.
Savingthe Work space:
Wheneverythingisdoneandwhenyouarehappywithyourcustomarrangement, then
simply go to WindowWork space Save Work space, name it what you want and
then it will remember the exact locations of where everything is so that you can
switch to other created work spaces and reload whichever one you want

AdobePhotoshopTolls
Followingtoolsareused toeditanimageinAdobePhotoshop
1. Marquee Tool:
Usedforselectingareasofanimage.Thistoolisusedtodrawselectionsbasedon
geometric shapes. Specifically, the marquee tool allows you to draw rectangular
and elliptical selections. To form the selection, simply click and drag the mouse.
2. MoveTool:
Usedformovinganobjecttoa differentarea ofthe canvas.
3. LassoTool:
Used for selecting areas of an image that may not necessarily be comprised of
straightlines.Tocreateafreeformselection,simplychoosethelassotoolandclick and
drag on the canvas. The selection will follow your drag.
4. Magic Wand Tool:
Usedforautoselecting large areasofanimagethatissimilarin color.
5. CropTool:
Usedforreducingtheimagetoacertainarea
6. SliceTool:
Usedtoasliceanimageintodifferentsections;generallyusedforthecreationof
images for a web page design
7. HealingBrush Tool:
The Healing Brush tool allows you to fix image imperfections such as scratches,
blemishes,etc.Bysamplingthesurroundingareaorusingapredefinedpatternyou can
blend the imperfections into the rest of the image.
8. BrushTool:
BrushtoolsisUsed withthe mousetosimplydrawlinesonyourimage,paintthe



imagewithdifferentshape
9. CloneStampTool:
UsedtocloneorcopyoneareaofanimagetoanotherobjectFirstweselectthe source by
holding Alt and click an area of the image to copy, then click on a different area to
copy it there.
10. HistoryBrushTool:
Thehistorybrushusesapreviousstateorsnapshotofanimagethetoolmakes a copy
of the image as it was in a previous state, then uses the content of this copy to
paint with.
11. EraserTool:
Thistoolisused toerase certainareasofanimage Click onthe erasericonand
thenclickonanareaonthecanvasandwhileholdingthemousebuttondown, start
dragging the cursor around the canvas the aria under the eraser will be deleted.
12. GradientTool:
TheGradienttoolallowsyoutospecifyagradientofcolor.Usingitisfairlyeasy, you
simply choose the gradient tool from the toolbox click on the canvas and drag
out an area to fill with the gradient
13. BlurTool:
TheBlurToolunfocusedimageareas.
14. Dodge Tool:
TheDodgetoollightentheareasoftheimage.Themoreyoupaintoveranarea with the
Dodge tool, the lighter it becomes.
15. PathSelection Tool:
Usedmergeoverlappingcomponentsintoasinglecomponent
16. Type Tool:
Used toplace textonan image
17. Pen Tool:
The first is the Pen Tool, you can use this tool to create a vector, there are &
handlespresentineverypointyoumade,thishandleisusedtoadjusta curveor change
the position of the point
18. RectangleTool:
Usedtodrawrectanglesandotherpolygons
19. NotesTool:
Usedtoleavenotesforyourselfonyourimage
20. EyedropperTool:
Theeyedroppertoolisusedtopickupacolorvaluefrom thecanvas.Thisisavery



usefultoolbecausetherewill bemanytimeswhenyouwanttoswitchcolorswhile
painting to a color already on your canvas and you do not want to go all the way
through the color chooser dialog In these cases, simply click on the eye dropper
tool in the toolbox and click on the color you want to select inside the canvas.
Whenyoudoso,yourforegroundcolorinyourcolorboxeswillchangetothe selected
color.
21. HandTool:
Used toquicklyviewdifferentareasofan image
22. Zoom Tool:
Thistoolusedtozoominandoutofanimage. Thezoomtoolallowsyoutozoomin on the
image to get a better idea of the actual pixel makeup of a section you are working
on.
23. ForegroundIBackground Color:
Usedtosettheforeground(front)andbackground(back)colorsofanimage;can also be
used to change the colors of text, etc. Click on the boxes to change the colors (a
new window will appear).
24. EditModes:
Usedtoswitchbackandforthbetweenmodes
25. SwitchScreenModes:
Usedtoswitchbetweenfullscreenandstandardscreen modes
26. JumptoImage Ready:
UsedtoeasilylaunchtheImageReady program

WhatisLayerandhowwecreatenew layer?
OneofPhotoshopsmostpowerfulfeaturesistheabilitytocreateandusemultiple layers
within the same image.
Alayerissimplyoneimagestackedontopofanother.Youcanseethrough transparent
areas of a layer to the layers below.
Eachlayereditedindependentlyofeachother.Andthenlatercombinedtoforma single,
flat image when you first create an image, you will be working with the
Backgroundlayer.You cannotalwaysuse all effectson abackground layer,soyou may
wish to start working directly with normal layers.
CreateNew Layer:-
1-Tocreate anewlayer,Followthe FollowingSteps
2- ClicktheLayermenu
3- SelectNew fromtheLayermenu (orclickShift+Ctrl+N).
4- Inthe new windowthatpopsup,clickOK.
5- YoucanalsoinsertnewlayerformLayers,Channels,andPathsPalette.



6- Forthispurpose click onthe NewlayerIconfrom Layer Palette.
7- YouwillnoticethatLayer1isaboveBackgroundinthewindow

WhataretheElementsofLayers Palette?
InThelayerswindowswecanseethefollowingoptions
1. PaintbrushSymbol:
Thissymbol(andtheblueshadingofthelayer)notesthecurrentlyactivelayer
2. ShowIHide Layer:
Whentheeyeiconisvisible,thelayerisdisplayedinyourproject.Iftheeyeis clicked, then
the layer is hidden but not deleted.
3. LinkIcon:
Indicates if the layer is currently linked to another layer.
When linked, layers act lockedtogether (and will move
with each other, accordingly), but still remain separate
layers. Layers can be linked together by selecting one layer,
andthenclickingtheboxesintheotherlayerstodisplaythe Link
icon (number three on theabove list and image)
4. Background:
TheBackgroundistechnicallynotalayer,however,itcanbe
edited. It is the bottom-most portion of the image
5. Layer:
Eachlayerhasitsownname(defaultisbynumbering)Click a
player’s name to edit on that layer.
6. Effects:
When you add effects to a layer, a sub-menu appears with that layer listing the
effectappliedtoitDouble-clickaneffectsnametobringupthateffectsmenuto make
adjustments
7. AddaLayerStyle:
Bypickinganoptionfromthismenu(suchasDropShadow,InnerGlow,orBevel and
Emboss), you can apply special effects to a layer
8. AddaMask:
Masksareusedtohidepixelsona layerinordertoviewtherestoftheimage. Layer masks
are either a black or white background color
Thedefaultcoloriswhite,whichletspixelsbe seen,whileblack hidespixels
9. CreateaNew Set:
Bymakinganewset,youcancreate aseparatefolderforlayerstorage
10. CreateNewFillorAdjustmentLayer:



Theoptionsinthismenuallowyoutochangethe colorpropertiesanddimensions of a
layer For example, you can make a layer lighter or darker, add a gradient (a
blending of two colors), or invert the entire layer
11. Create aNew Layer:
Clickingonthisiconcreatesa newlayeryoucannameyourlayer inthetextbox that
appears and position it in the palette
12. Delete a Layer:
Deletesthecurrentlyselected layeryoucanalsodraga layertothe trash.
13. Opacity:
Usethistoadjustalayersopacity(itstransparency)

WhatisTransforminPhotoshop?
InPhotoshop,Transformisusedtoscale,rotate,skew,andjustdistortthe perspective of
any graphic you’re working with in general.
ScalingGraphics
OneofthemostbasictransformationsPhotoshopiscapableofisscalingagraphic Scaling
allows you to enlarge or shrink a graphic around a reference point.
Toscaleagraphic,wegotoEdit>Transform>Scale.
A set of handles willappear around our selected elements in the document (such
aslayers,orshapes)bymovinganyoneofthesehandles,wecanadjustthesizeof the
object. To apply the transformation, hit Enter.
ConstrainingProportionswhileScaling
Often times, you II find it necessary to constrain the proportions of your objects
when scaling. This can easily be achieved by Holding Shift while dragging a
transformationhandle.Youcanadditionallyscalefromthecenterreferencepoint
byHoldingALTorcombinethetwobyholdingshiftandaltatthesametimewhile scaling
Rotating Objects in Photoshop
ToRotateanObjectinPhotoshop
Go to Edit > Transform > Rotate.
Handles will appear as they did with a Scaling Transform, but instead of dragging
one of these,go justoutside ofthe objectuntil you see acurvedarrowrotate icon.
Atthispoint,simpledragleftorrighttorotatetheselectedobject.Onceagain,you must
finish applying the transformation by pressing Enter.
Youcanrotatein15DegreeIncrementswiththisusefullittleshortcut.Whileyou
™rerotatinganobject,simplyholddowntheshiftbutton. Skew,
Distort, and Perspective Transformations
Thenext3transformationsareallsimilar,becausetheyare allcontrolledby



dragginghandles.
That is not to say that they are used to do the same thing, they simply all operate
inthesamemanner.YoucanapplyaSkew,Distort,orPerspectiveTransformation from
Edit > Transform. Skew
Skewtransformationsslantobjectseitherverticallyorhorizontally.
Distort:DistorttransformationsallowyoutostretchanimageinANY direction freely
PerspectiveThePerspectivetransformationallowsyoutoaddperspectivetoan object
FreeTransform:
YoucanalsouseFreeTransformformEditmenu.OrPressingCTRL+TKeyand perform all
the above operation on same time.

WhatareLayerStyles?
Layer styles are special effects that can be quickly and easily applied to individual
layersinPhotoshoptodrasticallychangetheappearanceofsomethinginverylittle time.
They can be preset, customized, or even saved and used for later.
One of the useful properties of Layer Styles is there relationship to the layer
contents.Sincethestyleisactuallyaseparateentitythatisjustlinkedtothelayer, it will
continually update itself as a layers contents are edited or moved.
Furthermore, theeffectscaneasilybeadjustedafterapplyingthem,makingthem non-
destructive in nature.
UsingLayerStyle Presets
PhotoshopcomespackedwithagoodnumberofLayerStylePresets,allwhichare
accessible through the Styles Palette (Window > Styles) To apply a Layer Style,
selecttheLayeryou’dliketoworkwithinyourdocumentfromtheLayersPalette, and
then select the Layer Style, which you would like to apply.
HowweUndo thePreviousSteps?
Most operations can be undone if you make a mistake. Alternatively, you can
restoreallorpartofanimagetoitslastsavedversion.Butavailablememorymay limit your
ability to use these options.
Toundothelastoperation:ChooseEdit>Undo. We
can also use CTRL +Z command
BydefaultifyouwanttoundomorethenonstepsthenpressCTRl+ALT+ZKeyata time.
HistoryPlateforUndo:
WecanalsouseHistorypaletteforthispurposeTheHistorypaletteletsyoujump
toanyrecentstateoftheimagecreatedduringthecurrentworkingsession.Each



timeyouapplyachangetoanimage,thenewstateofthatimageisaddedtothe palette
For example, if you select, paint, and rotate part of an image, each of those states
is listed separately in the palette You can then select any of the states, and the
imagewillreverttohowitlookedwhenthatchangewasfirstappliedYoucanthen work
from that state.
To displaytheHistory palette:
ChooseWindow>History,orclicktheHistorypalettetab.

WhatisRevertandPurgecommand:
ChooseFile>Revert.
WhenyouRevertanimage,youreturntheimagetothelast time
it was saved. Its means that when we apply Revert
Command thenAll the stepsUndoAutomaticallyand Image
become In The Initial State when its saved.
PurgeCommand:
Purge command is used to free the buffer where previous action was stored. For
thispurposeweChooseEdit>Purge,andchoosetheitemtypeorbufferyouwant to clear.
If already empty, the item type or buffer is dimmed.
ThePurgecommandpermanentlyclearsfrommemorytheoperationstoredbythe
command or buffer; it cannot be undone. For example, choosing Edit > Purge >
Histories deletes all history states from the History palette. Use the Purge
command when the amount of information held in memory is so large that
Photoshop's performance is noticeably diminished.
HowweLinkingLayers?
Inthelayerspalette,youcanlinkdifferentlayerstoeachother.Thiswillallowyou to move
them together (when you are on the 'V" move tool)
Just click on the layer you want to be on and then click on the link box and pick
otherlayersinthepalettetolinktobysimplyclickingontheirlinkbox;thiswilllink those
layers to this layer. You can unlink by clickingthe link boxagain. You canlink fast by
clicking and dragging down the entire row (you can also unlink this way).

AdobePhotoshopNavigationTools
Navigation in Photoshop is a very import aspect of retouching. It's important that
we'reabletoquicklyzoomin/out,movethecanvasorcomparetheretouchedpart of an
image with the original. The Zoom Tools and Hand tools are both navigation tools.
ZoomTool: ZoominginononeparticularareainanimageiseasySelectthe Zoom



Tool icon in the Tool Bar and use the mouse to select the area that you want to
magnify and release the mouse button. Navigation is also don form navigator
palette AndalsowithshortcutkeysthroughkeyboardCTRL+ (+)forZoomoutand
CTRL+(-)keyforZoomIN.ifwehaveawheelmouse;rollingthewheelawayfrom us allows
us to zoom out, rolling the wheel towards us allows us to zoom in. Note sometimes
you need to hold down the Alt key when you use the scroll wheel.
HandTool:ceIfyourimagedoesn'tfitinyourdocumentwindow,thenyouhaveto select
the Hand Tool in the toolbar and use your mouse to move your image by clicking
and dragging it inside your document window. For this purpose select. The hand
tool and drag the image with the help of mouse. You can also use wheel mouse by
rolling the wheel up down and CTRL + rolling wheel Left and Right

HowweResizeanImageinAdobePhotoshop?
If we want to adjust the height and width you can resize your image to any
dimensions you wish. Select Image Size from the Image menu. The default in
Photoshop isto keep image resizingatConstrain Proportions.Thismeansthatif the
height is changed, the width will be changedat the same ratio. Thiskeeps your
image looking approximately the same, only at different sizes. If you wish to
change this,justun-click the Constrain Proportionscheckbox atthebottom of the
mage Size window. You can change the image size either by pixels or
percentages.Useeitheryouwishtoeitherenlargeorreducethesizeofyourimage (keep
in mind that enlarging images will reduce the quality)

AdobePhotoshopMovingTool
The move toolallowsyou to movea selection orentire layerby dragging itwith
yourmouseorusingyourkeyboardarrowskeys.Themovetoolislocatedatthe top
right of the Photoshop Toolbox.
Whenthemovetoolisselected,clickanddraganywhereintheimageBydefault,if an area
is selected the selection will be moved, otherwise the whole layer will be moved.
See the options bar for more options
Alternatively,useyourarrowkeystomovetheselectionorlayerin small increments.
Hold down the Shift key to move in larger increments.

AdobePhotoshopMarqueeTools
Themarqueetoolsareselectiontoolswhichallowyoutoselectrectangles,ellipses and 1-
pixel rowsand columns. Themarquee toolsare located atthe top leftofthe
Photoshop Toolbox. Click and hold your mouse over the marquee tool to see the
four options
RectangleMarquee



Makearectangularselection.Holdtheshiftkeydowntoconstraintheselectionto a
square
EllipticalMarquee
Makeanellipticalselection.Holdtheshiftkeydowntoconstraintheselectiontoa circle.
SingleRowMarquee
Makeahorizontalselection1pixelhigh.
SingleColumnMarquee
Makeaverticalselection1pixelwide.
HowweselectThePartofany imagebyMarqueeTools
Open anImage
SelectThe MarqueeToolsformToolBoxorclick ontoolbarandPressM.
SelectanyonetoolfromRectangularMarqueeToolorEllipticalMarqueetoolor any one
which you want to need depending on your selection.
Note that a square is a special case of rectangle and a circle is a special case of
ellipse. To get a square from a rectangular marquee or a circle from an elliptical
marquee, simply press and hold the SHIFT key while you drag out your selection.
For anti-alias your selection, you can use the anti-alias checkbox or the feather
checkboxorboth.Thefeatheringcheckboxsimplyaffordsanextradegreeofanti- aliasing.

AdobePhotoshopMagicWandTool
TheMagicWandtoolUsedforautoselectinglargeareasofanimagethatis similar in color.
The tool is located near the top of the Photoshop Toolbox.
When you click an area in an image with the magic wand, all areas which are a
similarcolorareselected.Youcanspecifyvariousoptionstodeterminetheexact
selection.
UsingtheMagicWandTool
Selectthe magic wandtoolinthe toolbox.
Intheoptionsbar,selectaTolerancevalue(0to255).Thisdetermineshowclosely to
match colors -higher tolerance means a larger selection.
i. CheckAnti-aliasedtodefineasmoothedgetotheselection.
ii. CheckContiguoustoselectonlyareas,whicharejoined together.
iii. CheckUse AllLayerstoselectareasfrom alllayers.
iv. Clickthe imageinanarea,whichyou wantto select
Note:YoucanaddandsubtracttotheselectionbyusingyourShiftandAltkeys,or clicking
the selection buttons in the options bar.



AdobePhotoshopLassoTools
Lasso Tool is used for selecting areas of an image that may not necessarily be
comprisedofstraightlines.Tocreateafreeformselection,simplychoosethelasso tool
and click and dragon thecanvas. The selection will follow yourdrag. The lasso tools
allow you to select precise areas of an image by drawing or tracing the selection
outline.
Therearethreelassotoolsavailable
SimpleLassoTool
Thisisafreehandselectiontool.Clickandholdyourleftmousebuttononthe image and
draw your selection.
PolygonalLassoTool
Similartothelassotool,exceptthatinsteadofholdingyourmousebuttondownto draw,
left-click on various points to create a selection with a series of straight edges.
YoucanalsoholddowntheAltkey(Windows)orOptionkey(MacOS)todraw freehand
sections.
MagneticLassoTool
This is a very handy tool for selecting areas which have reasonably well-defined
edgesLeft-clickatthestartingpointofyourselectionandsimplymovethemouse
alongtheedge."Fasteningpoints"areautomaticallymadeatvariouspointsalong the
edges. Left-click at any time to add a fastening point manually
ToCompleteaSelection
Tofinishdrawingaselection,eitherclickontheselectionstartingpointordouble- click
anywhere.
UseofLassoTool
1. SelectthelassotoolinthetoolboxandselectSimpleLasso Tool.
2. Clickandholdyourleftmousebuttonontheimageanddrawyour selectionand end at
the start point.
3. Your selection is done.
UseofPolygonalLassoTool
1. SelectthelassotoolinthetoolboxandselectPolygonalLasso Tool.
2. Left-clickatthestartingpointofyourselectionandsimplymovesthemouse along
straight edge.
3. BypressingLeft-clickatanytimetoaddafasteningpointandthensimplymove the
straight line.
4. Tofinishdrawingaselection,eitherclickontheselectionstartingpointor
double-click anywhere.



Useof Magnetic LassoTool
1. Selectthelasso toolinthetoolbox
andselectMagnetic LassoTool.
2. Left-clickatthe startingpointof your
selectionandsimply movesthemouse
alongthe edge.
3. "Fastening points" are automatically
madeatvarious pointsalongthe
edgesLeft-click at anytimetoadda
fasteningpointmanually
4. Tofinishdrawingaselection,eitherclickontheselectionstartingpointor
double-click anywhere.

AdobePhotoshopSliceTool
Used to slice an image into different sections; generally used for the creation of
images for a web page design. The slice tool is located in the top section of the
PhotoshopToolbox.TherearetwotoolsSlice(whichcreatestheslices)andSlice Select
(which enables you to select and modify existing slices)
Howweslicetheimagewith Slice Tools
Slicedimagesarecommonlyusedforwebdesignwork,whichsometimesrequires
images to be broken up in this way
UsingtheSliceandSliceSelectTools
1. Selectthe slicetoolinthe toolbox.
2. Clickanddragovertheareayouwishtomakeintoa slice.
3. Releasethemousebutton-Photoshopautomaticallycreatesthenecessary
number of slices, with the active slice highlighted
4. Usingthesliceselecttool,you canmoveandresizeslicesbydragginginsidea slice,
or by dragging the handles.
5. Toexporttheseparateimages,chooseFile>SaveforWebfromthePhotoshop File
menu.
6. Whenyousavethefileyouwillhavetheoptiontosavetheimagesand/oranew HTML
page to contain the images.



AdobePhotoshopHealingBrushTool
The Healing Brush tool allows you to fix image imperfections such as scratches,
blemishes,etc.Bysamplingthesurroundingareaorusingapredefinedpatternyou can
blend the imperfections into the rest of the image.
UseofHealingBrushTool ThehealingbrushtoolislocatedinthePhotoshop Toolbox, on
the left side.
UseofHealingBrushTool
1. Selectthe healingbrushinthetoolbox.
2. Checkthesettingsintheoptionsbar andadjustifnecessaryOptionsinclude
3. Brushsize
4. Blendingmode
5. Source(Sampledfromtheimageorpre-definedpattern)
6. Aligned
7. Ifyou'reusingsampledmode,Alt-clickanareaneartheimperfectiontodefine the
starting point (Select the sample which you want to mix on the spot)
8. Nowclickonthespotwhichyouwantto remove.
9. Done.

AdobePhotoshopPatchTool
ThePatchtoolishandyforrepairingimageflaws.Justlikespotontheimageand cracks
colors etc. To fix these problems first you define a selection that needs repairing.
Then you drag the selection to a source area to make the repair.
1. OpenanimageinPhotoshop(File>Open)andselectthePatchtoolorpress(j key).
2. Tomakesuretherearenocurrentselections,choose Select>Deselect(CTRL+D) key.
3. UsingthePatchtool,drawamarqueearoundthearea to repair.
4. Clickinsidetheselectionanddragtheselectiontodefinethesourceforthe repair.



AdobePhotoshopCloneStampTool
With the help of Clone Stamp we can Clone or copy one area of an image to
another. The process involves setting a sampling point in the image which will be
usedasareferencetocreateanewclonedarea.SelecttheCloneStamptool,then
checkthe settingsinthe optionsbar.Makesure youhavea brushsizeappropriate for
the job.
Thefollowingsettingsarefairly typical
1. Aligned. If this option is selected, the new cloned image will be drawn
continuouslyevenifyoureleasethemousebuttonwhiledrawingifitisdeselected, the
clone will begin drawing from the sampling point each time you release the mouse
and resume painting
2. UseAllLayersifthisoptionisselected,informationwillbeusedfromallvisible layers.
Otherwise only the active layer will be used.
HowwecloneTheImageonotherPlace
1. Openthe image
2. Hold down theAltkeythe cursorwill changeto a targetClick the pointyou wish
touseasa samplingpoint(ClickonthatPointwhichyouwanttocopy).Thiswillbe used as
the reference point for cloning
3. Clickanddrawwhereyouwanttheclonedimagetoappear
4. Asyoudraw,acrosswillappearontheoriginalimagewhileacorresponding circle
appears where you are drawing

AdobePhotoshopEraserTool
Photoshop'serasertoolcanbefoundinthesecondgroupoficonsinthetoolbox.It has
three variations Eraser, Background Eraser and Magic Eraser.



Theeraserisbasicallyabrushwhicherasespixelsasyou dragitacrosstheimage Pixels
are erased to transparency or the background color if the layer is locked.
Whenyouselecttheerasertool,youhavevariousoptionsavailableinthetoolbar: Brush
Options include the size of the eraser, hardness of edges andvarious styles. Brush
options are not available in block mode.
Mode:TherearethreeoptionsBrush(softedges) Pencil
(hard edges)
Block(squarebrushsize)
Opacity:
100%opacityerasespixelscompletely,0%doesnoteraseatall.50%issemi- transparent
(or coloured) Opacity is not available in block mode.
Flow:Determineshowquicklytheerasureisappliedbythebrush.Lowersettings produce
a more subtle effect. Only available in brush mode.
Airbrush:Usetheeraserasanairbrush.Onlyavailableinbrush mode.
ErasetoHistory:Erasestoasavedstateorsnapshotoftheimage.Tousethis feature, click
the left column in the history palette next to the desired state. Background Eraser
Tool
The background eraser tool allows you to remove the background colour from an
image or layer. When you click the image, the eraser samples the colour at the
CentreofthebrushanderasesthiscolourasyoudragOptionsinthetoolbarallow

you to specify the type of erasure,
colourtoleranceandsamplingmethod.

Use of Background Eraser
OpenTheImagefromwhichyouwanttodeletethebackgroundcolour. Click on
Eraser tool and select the Background Eraser.
NowsetTheSamplingoptionfromoptionbarContinues,Once,Sampling.
Ifyouselectcontinuesthenwhenyouclickontargetthecolourfordeletionis selected
under the Background Eraser.
Ifyouselectoncethenwhenyouclickfirsttimeontargetthecolourfordeletionis selected
under the Background Eraser and remain until you click again



MagicEraserTool
Themagicerasertoolerasesallcolourswithinasettolerance.Thisisessentially the
same as using the magic wand and hitting Delete. Using this tool you don't need
to drag “just click once.
Use ofMagicEraser
1. Opentheimage
2. Selectthe MagicEraserToolfrom Eraser.
3. NowSettheToleranceofcolourfromOptionBar.(Lowtolerancedeletethe 100%
match colour) 4- 4. Click on the colour which you want to delete.
5. Finish.

AdobePhotoshopBlurTool
The Blur Tool unfocused image areas. Blurring can be useful if some element of
yourimagestandsouttoomuch,andyouwouldliketosoftenitIfyouwanttoblur a whole
layer, or a large part of one, you will probably be better off using one of the Blur
Filters.
UseofblurEraser Open
the image
SelectThePartofimagewhichyouwanttoblur. Select
the blur Tool form tool Bar.
AdjusttheStrengthofblur.
Painttheselectedariaoftheimagewithblurtool. Finish.
Ifyouwanttoburwholeimagethendontselecttheimage. Select
the Filter Menu.
SelectTheBlur,andthenselectSimpleblurorGaussianblur(MoreBlurThe image).

AdobePhotoshopSharpenTool
The Sharpen tool increases the contrast among adjacent pixels to give the
impressionthatthingsaresharper.Sharpeningaimagemeansmakingtheedgesof the
objects more prominent
UseofSharpen
Opentheimage
SelecttheSharpenToolform(blur,sharpen,smudgegroup)toolBar.Adjustthe Strength
of Sharpen.
Painttheselectedariaoftheimagewithsharpentool.Finish.
Ifyouwanttosharpenwholeimagethen selecttheFilterMenu.



SelectThe Sharpen,andthenselectSharpen orSharpenEdges

AdobePhotoshopSmudgeTool
Thesmudge canbeusefulifyouwanttoblurouttheedgesofphotosSmudgeTool spreads
and mixes content of image areas.
Useof Smudge
Select the Smudge tool.
Choosebrushsizeandstyle. Set
the tool's strength.
Dragonthe image
IntheOptionsbar,youcanalsospecifytheeffect's"Mode".

AdobePhotoshopPen Tool
ThePenToolcreatesstraightlinedandsmoothcurvedvectorshapesandpaths Use of
Pen
1. Inthe Toolbox,selectthe PenTool.
2. Chooseadrawingmodefromoptionbar.ForexampleShapeLayer.
3. Clickontheimagetosetthefirst anchorpoint.
4. Setanotheranchorpointtoaddasegment.
5. Youcanadd ananchor point.
6. You canalsodeleteanchor point.

AdobePhotoshopHistoryBrushTool
History Brush is use to restore the image attribute from an earlier point in a
picture'shistory.WesaythatHistoryBrushToolallowsyoutopaintandreveal previous
states of images
UseofhistoryBrush
Forexampleifwedeleteanypartoftheimage.Then Select
the History Brush Tool.
Choosebrushsizeandstyle
Painttheariawhichisdeletedinpreviousstep. You
can see that all the deleted part recovers.

AdobePhotoshopCropTool
Thistoolisusedforreducingtheimagetoacertainarea(cropping)Insimpleword we say
that Crop Tool cuts out a defined area of the image
UseofCropTool



SelecttheCropToolfromtoolbox.
Clickontheimageanddrawarectangleholdingmouse'sbuttonpressed. When
you release the button a bounding box appears
Toapplycroppress[Enter]keyorright-clickontheimageandchooseCropfrom context
menu.
Brush ToolandPencilTool
Photoshop provides two tools for drawing (painting) directly to the image. The
brushtoolandthepenciltool.Bothtoolsworkbasicallythesameway.Pressleft- click and
drag your mouse in the image to draw. Painting uses the currently selected
foreground colour.

AdobePhotoshoptheBrushTool
Thebrushtoolpaintswithsmoothedges.TheoptionsbarlookslikethisSettings.
1. Brush:Thesizeofthe brush.
2. Mode:Theblendingmode.FormostworkNormalwillbethebestoption.
Experiment with other modes to see what they do.
3. Opacity:Anythinglessthan100%willallowtheunderlyingimagetobeseen.
4. Flow:DetermineshowquicklypaintisappliedLowersettingproduceslighter
strokes.
TheAirbrushTool
Theairbrushoptionallowsyoutoapplygradualtonestoanimage,likeatraditional airbrush.
Thepencil Tool
Thepenciltoolbehavesmuchlikethebrushexceptthatithashardedges.The pencil tool
options are the same asthe brush tool, except there is no airbrush option
PaintBucketTool
The paint bucket tool fills an area of an image based on colour similarity. Click
anywhereintheimageandthepaintbucketwillfillanareaaroundthepixelyou clicked.
The exact area filled is determined by how similar each adjoining pixel is to the
pixelyouclickedon.Youcanadjustthissetting inthe optionstoolbarbychanging the
tolerance value (make sure the paint bucket tool is selected first) A low
tolerancemeansonlyverysimilarcolourswillbeaffected,ahightolerancemeans more
pixels will be affected. Therange is0 (exact colour matches only)to 255 (all colours)
Othersettingsintheoptionsbarinclude
1. Fill:Foregroundcolour(i.ethecurrentlyselectedcolour)orPattern.Ifyou select



pattern,thenextdrop-menubecomesactiveandyoucanchooseapatterntouse.
2. Mode:Thesame"blendingmodes"foundinmanyothertools,includingnormal,
dissolve, lighten, darken, etc.
3. Opacity:Setlowertomaketheunderlyingimagepartiallyvisible.
4. Anti-alias:Makesmootheredgesbyblendinggraduallywithadjoining pixels.
5. Contiguous:Whenthecontiguouscheckboxisselected,onlypixelsthatare
connected to the original pixel are filled.
GradientTool
Gradient tool allows you to fill a gradient (multi color effects) of color. Simply
choosethegradienttoolfromthetoolboxclickonthecanvasanddragoutanarea to fill
with the gradient The larger the drag the more gradual the gradient will be.
Pressing and holding the shift key will create perfectly aligned gradients
UseofGradient Brush:
1. Createanewblank layer.
2. SelectthepaintbuckettoolandselectGradienttoolorpressGthen shift+ G.
3. Clickanddragagradientpathtofillthe canvaswithagradient
4. Finish

AdobePhotoshopDodgeTool
TheDodgetoollightensimageareas.YoucanpaintoveranareawiththeDodge tool, for
making lighter the image or selected aria.
UseofDodge Brush:
1. Inthe Toolbox,select the Tool.
2. Choosebrushsizeandhardness.
3. Setexposure(stroke strength)
4. Dragonthe image
5. IntheOptionsbar,youcanchoosealsothetool'srange:Shadows,Midtonesor
Highlights.

AdobePhotoshopBurn Tool
The Burn tool is used for darkens image areas or whole image you can paint over
anareawiththeBurntool,forincreasethedarknessintheimageorselectedaria. Use of
Burn Brush
1. Inthe Toolbox,selectthe Burntool.
2. Choosebrushsizeandhardness.
3. Setexposure(stroke strength)
4. Dragonthe image



5. OntheOptionsbaryoucanchoosealsothetool'srangeShadows,Midtonesor
Highlights.

AdobePhotoshopType(Text)Tool
TheTypetoolisuseforAddingtheTextinanimageTypetoolprovideHorizontal Type tool,
Vertical type tool, Horizontal Type Mask and Vertical Type Mask.
TheHorizontalTypeToolcreatesandeditsvector-basedtextinaseparatelayer. The
Vertical Type Tool creates and edits vector-based text in a separate layer The
Horizontal Type Mask Tool creates type-shaped selections.
TheVerticalTypeMaskToolcreatestype-shaped selections.
UseofType Tool
1. SelecttheType tools(ForExampleHorizontalType Tool)
2. OntheOptionsbar,setthefont optionsfamily(style),size,colourandanti-
aliasing method.
3. Click onyourimageand type.
4. While you are typing, most of the other Photoshop functions are not available.
Whenfinished,clickonanytoolintheToolboxoronalayerinthe Layerspaletteto apply
the typing and return to the standard editing mode.

AdobePhotoshopShapeTool
In Photoshop youcan also workingwith shapes Photoshop provide theRectangle
Tool,theRoundedRectangleTool,theEllipseTool,thePolygonTool,and theLine Tool.
TheRectangleToolcreatesrectangularshapesandpaths(shape outlines)
TheRoundedRectangleToolcreatesrectangularshapesandpaths(shapeoutlines) with
rounded corners.
The Ellipse Tool creates elliptical shapes and paths (shape outlines).
ThePolygonToolcreatespolygonalshapesandpaths(shapeoutlines). The
Line Tool creates line shapes and paths (shape outlines).
TheCustom Shape Toolcreatesversatileshapesandpaths(shape outlines).
UseofShapes Tool
1. Selectthe shape tools(ForExamplerectangle Tool)
2. PressingandHoldingLeftmousebuttondrawa rectangle.
HowwedrawCustom Shape
TheCustom Shape Toolcreatesversatileshapesandpaths(shape outlines):
1. Selectthe CustomShape Tool.
2. Inthe Optionsbar,choosea drawingmode tocreate vectorshape layersclick
Shapelayersbutton;todrawpaths(shapeoutlines)clickPathsbutton;tocreate



rasterizedshapesincurrentlayerclickFill pixels.
3. SelectashapeonCustomShapepicker.
4. ClickonnexttobuttonontheOptionsbartosetgeometryoptions
5. Chooseshape colour.
6. HoldleftbuttonandDragonthe image
7. Theselectedshapedrawsonyourimage

AdobePhotoshopEyedropper Tool
The Eyedropper Tool defines the foreground I background colour. The Eyedropper
tool is used to sample a colour from an image to use this colour further. It's
practicalasitfacilitatescolourselection,forexample,anappropriatecolourforthe skin
from another image
WhenyoupickacolourwiththeEyedroppertool,itappearsastheforeground colour in
the Toolbar. For the background hold the Alt-key while selecting the colour with
the Eyedropper tool.
UseofEyedropperTool
1. SelecttheEyedropperTool.
2. Clicksomewhereonyourimagetodefinetheforeground colour.
3. HoldingAltandThenclicktosetthebackgroundcolour.
4. In the Options bar, you can change sample size (the Eyedropper's range) the
"PointSample"picksupthecolourfromthepixelyouclickonalltheothersamples read
average values from larger areas.

AdobePhotoshopColoursampler Tool
Thistoolisusedforviewingthecolourvaluesindefinedspotsofyourimage.These values
display in the Info palette window
UseofColoursamplerTool
1. SelecttheColoursamplerTool.
2. Clicksomewhereonyourimage.
3. Sampler#1appearedinInfopaletteshowsthecurrentvaluesinyourcolour
channels.

AdobePhotoshopMeasure Tool
TheMeasureToolcalculatesdistancesandanglesinthework area.
UseofMeasure Tool:
1- IntheToolbox,selecttheMeasureTool.
2- Tocalculatedistancefromonepointintheworkareatoanother,dragline
between the points
3- IntheInfopaletteandintheOptionsbar,youcanreadthemeasuringlinedata.



AdobePhotoshopZoomTool
TheZoomToolmagnifiesIreducestheimageviewwithoutchangingtheimage data.
UseofZoomTool
Selectthe ZoomToolfromtoolbox.
Clickonanyarea ofyourimage tomagnifyit
Toreducetheview,clickthe"zoomout"buttonontheOptionsbar;thenclick on your
image.
HandTool
TheHandToolisusedfornavigateaneditedimage,whenitisnotcompletely visible in its
window.
Useofhand Tool
SelecttheHandToolfrom toolbox.
Dragyourimagetobring thehiddenareasintothe view.
The3buttonsontheOptionsbarallowyoutochooseoneof3standardviewing modes -
Actual Pixels, Fit on Screen or Print Size.

AdobePhotoshopNotesTool
Whenwewanttoaddsomenoteswithimagethenweusenotes tool.
UseofNotesTool:
1. Selectthe NotesToolfromtoolbox.
2. Dragontheimagewhereyouwanttoattachanote.Aresizablewindow
appears.
3. Type yourtextandclose thenote.
4. Wesettheauthor'snameandsetfontoptionsfromtheoptionbar.
5. Wecanalsoeditournotes,toedit anote,openitbydouble-clickonit,and make
your changes
6. WecanalsohideorshowournotesbypressingCtrl+Hshortcutorfrompull- down
menu Click on View and then Show and then Annotations.
7. Wecanalsodeleteournotestodeleteanote,either clickonnotesandpress Delete
key.
8. Ifwewanttodeleteallnotesthen clickon"ClearAll"buttonintheOptionsbar.

ExtractioninAdobePhotoshop
InPhotoshopExtractcommandisusedtodeletethebackgroundformtheobject.
Extracting a object from the background usually in order to place it on another
background or make the background transparent
ExtractingImagesfromtheirBackground



1. Openthe file.
2. SelectFilterMenuandselectExtract.
3. Inappearingwindowselectthehighlighttoolset thebrushsizeandpaintathick line
around the image Make sure the pen overlaps the both the feathers and back
ground.
4. InNextstepselectthe paintbucketandfillintheareayououtline.
5. Innextstep clickonthe Previewbutton.
6. SelectOKandyourwillbereturnedtoPhotoshopsmainwindowandhavea picture
without background.
OptionofExtractWindow
TheExtractionwindowhasseveraltoolstohelpyourefineyourselectionandview what
the extracted image looks like on different collared backgrounds. The main
controls you have are as follows
1. Brush size:-
This specifies the width of the highlighter, eraser, clean-up and edge touch up
tools.Iftheedgeisclearly definedmakethesizeofthebrushsmaller,iftheedgeis fuzzy
use a thicker highlight brush size.
HighlightColour:
Highlightdefaultcolourisbrightgreen,thecolourcanbechangedtoanother colour if
the subject you are extracting has green as part of it
2. Fill:-
Defaultcolourisblue,thisdeterminestheareaofthepictureyouwanttokeep
3. SmartHighlighting:-
Select this option if you are highlighting a well-defined edge, it helps keep the
highlight on the edge and applies the highlight just wide enough to cover the edge
regardlessofthebrushsize.Intheorythissoundsgreatinpracticeifoftendoesnot seem to
help significantly
4. ExtractionOptions
TexturedImage:
Selectthisoptioniftheforegroundorbackgroundoryouimagecontainsa lotof texture.
Smooth:
Default is 0, enter a larger number if you want to increase the smoothness of the
outlineyoudrew.It’sbesttostartwith0orsmallvaluetoavoidunwantedblurring of
details.
Force Foreground:
Selectthisoptionifthe objectisespeciallyintricate orlacksaclearinteriore.g.you



cantrythisfeature onanimagelikegrassorsubjectwithlotsoffine hair.
5. TouchupExtractionTools
Cleanup Tool:
This tool is used to erase background traces in the extracted areas. The tool
subtractsopacityandhasacumulativeeffect.Youcanalsousethistooltofillin gaps in the
extracted object Holddown Alt “while dragging to add back opacity Edge Touch up
tool:
Thistoolsharpnessedgesandhasacumulativeeffect.Ifthereisnoclearedge,this tool
adds opacity to the object or subtracts opacity from the background
Note:Onceyoucompleteyourextractionwiththeextractfilteryoucontinueto clean up
the image using the Background eraser and the history brush tools.

WhatisColourSpace?WhatisRGB,CMYKColour
System?
The term colour space is interchangeable with the term colour mode. It’s simply
statesthecolourvaluemethodyouareusingtoworkwithyourimagesfromRGB, CMYK,
and grey scale and alike.
SelectingColourMode
GOtoImageMenuandSelectModeandthenselectthecolourmode.
RGBColour:
RGB stands for Red, Green, and Blue. These are the colour displayed by your
computer,andyoureTVItisthecombinationofthesethreecoloursthatprovide you all
the colours you see while watching movies online or a movie on your TV. CMYK
Colour:
CMYK stands for the four colours of in used by the printers. They are cyan,
magenta, yellow, and black. The K , because B was already spoken for in the RGB
colour space CMYK is what designers used to sends documents to professional
printersfrommagazine,poster,andalike.ItistheCMYKmodelthatgivetheterm four
colour printing its meaning
Grey Colour:
Greyscalecoloursdisplay256values ofgrey.Greyscale,isgreattousewhengoing for
that classic vintage look or mixing part of colour image with grey for emphasis on a
part of an image

AdobePhotoshopFilterEffectsinPhotoshop
Photoshopprovidebuilt-infilterseffectwecanapplythesefiltereffectsfromfilter menu.
ArtisticFiltereffect



Achieve a painterly or special effect for a fine arts or commercial project For
example,usetheCutoutfilterforcollagesortypetreatmentThesefiltersreplicate
naturalortraditionalmediaeffects.FormoreinformationaboutArtisticfilters,see
Artistic filters. For more on the Rough Pastels and Underpainting filters, see using
texture and glass surface controls.
BlurFiltereffect
Soften a selection or an image Blur filters are useful for retouching. They smooth
transitions by averaging the pixels next to the hard edges of defined lines and
shaded areas in an image. For more information about Blur filters, see Blur filters.
Note:Toapplya Blurfiltertotheedgesofa layer,besuretodeselectthePreserve
Transparency option in the Layers palette.
BrushStrokeFilter effect
Like the Artistic filters, the Brush Stroke filters give a painterly or fine-arts look
usingdifferentbrushandinkstrokeeffects.Someofthefiltersaddgrain,paint, noise,
edge detail, or texture to an image for a pointillist effect. For more information
about Brush Stroke filters, see Brush Stroke filters.
DistortFiltereffect
Geometricallydistortanimage,creating3Dorotherreshapingeffects.Notethat these
filters can be very memory intensive. For more information about Distort filters,
see Distort filters. For more about the Displace filter, see Defining undistorted
areas. For more on Glass filter controls, see Using texture and glass surface
controls.
NoiseFiltereffect
Add or remove noise, or pixels with randomly distributed colour levels. This helps
to blend a selection into the surrounding pixels Noise filters can create unusual
texturesorremoveproblemareas,suchasdustandscratches,fromanimage.The Add
Noise filter can be used to reduce banding in feathered selections or
graduatedfillsortogiveamorerealisticlooktoheavilyretouchedareas.Formore
information on Noise filters, see Noise filters (Photoshop)
PixelateFiltereffect
Sharplydefineaselectionbyclumpingpixelsofsimilarcolourvaluesincells.For more
information on Pixelate filters, see Pixelate filters.
RenderFiltereffect
Create 3D shapes, cloud patterns, refraction patterns, and simulated light
reflections in an image. You can also manipulate objects in 3D space, create 3D
objects(cubes,spheres,andcylinders),andcreatetexturefillsfromgrayscalefiles to
produce 3D-like effects for lighting For more information on the Render filters,



see Render filters. For information on the 3D Transform filter, see Transforming
objectsinthreedimensions.WhenusingtheCloudsfilter,generateamorestark cloud
pattern by holdingdownAlt(Windows) orOption (Mac OS) asyou choose Filter>
Render > Clouds.
SharpenFiltereffect
Focus blurry images by increasing the contrast of adjacent pixels They include the
Sharpen Edges (Photoshop) and Unsharp Mask filters, which find and sharpen
areaswheresignificantcolorchangesoccur(suchastheedges)TheUnsharpMask
filteriscommonly used forhigh-end colorcorrection. (See sharpeningimages)For
more information on the Sharpen filters, see Sharpen filters.
SketchFiltereffect
Addtexturetoimages,oftenfora30effect.Thefiltersalsoareusefulforcreatinga fine-
arts or hand drawn look. Many of the Sketch filters use the foreground and
background colour as they redraw the image for more information on Sketchfilters,
see Sketch filters. For information on the Cont © Crayon filter, see using texture
and glass surface controls. For a truer effect, change the foreground colour to one
of the common Cont © Crayon colours (black, sepia, sanguine) before applying the
filter.
StylizeFiltereffect
Produce a painted or impressionistic effect on a selection by displacing pixels and
by finding and heightening contrast in an image After using filters such as Find
EdgesandTraceContour(Photoshop)thathighlightedges,youcanapplytheInvert
command to outline the edges of a color image with colored lines or to outline the
edges of a grayscale image with white lines. (See Using the Invert command) For
more information on Stylize filters, see Stylize filters.
TextureFiltereffect
Giveimagestheappearanceofdepthorsubstance,oraddanorganiclook.
VideoFiltereffect
Include the NTSC (National Television Standards Committee) Colour filter, which
restricts the gamut of colours to those acceptable for television reproduction, and
theDe-Interlacefilter,whichsmoothsmovingimagescapturedonvideo.Formore
information on Video filters, see Video filters.
OtherFiltereffect
Let you create your own filters, use filters to modify masks, offset a selection
withinanimage,andmakequickcolouradjustments.Formoreinformationabout other
filters, see other filters. For more on the Offset filter, see defining undistorted
areas.



DigimarcFiltereffect
Embedadigitalwatermarkintoanimagetostorecopyrightinformation.Formore
information about Digimarc filters, see Digimarc filters.
ToPreviewandApplyaFilterEffect
Toapplyafiltertoanarea ofalayer,selectthatarea.
Toapplyafiltertotheentirelayer,leavetheimageunselected. Choose a
filter from the sub menus in the Filter menu.
Ifadialogboxappears,entervaluesorselect options
Ifthedialogboxcontainsapreviewwindow,usethefollowingmethodstopreview the
effect
Ifthedialogboxcontainssliders,holddownAlt(Windows)whiledraggingaslider to see a
real- time preview (real-time rendering) of the effect.
Clickintheimagewindowtocenteraspecificareaoftheimageinthepreview window
ConvertanImage toBlackandWhite

AdobePhotoshopUsingtheDesaturatecommand
TheDesaturatecommandconvertsa colourimagetoagrayscaleimageinthesame
colourmode.Forexample,itassignsequalred,green,andbluevaluestoeachpixel in an
RGB image to make itappeargrayscale.The lightnessvalue of each pixel does not
change. To use the Desaturate command:
ChooseImagemenuandselectAdjustmentsandselectDesaturate. Or
Press CTRL +Shift +U Key

AdjustingAutoColour Settings
Some time when digital photo have an issues of over or under-exposure, incorrect
white-balanceandhueproblemsThenphotoshopincludesalotofwaystocorrect these
problems.
Auto Colour:
Ifanimage seemstoowarm(tooorange)ortoocool(tooblue)thisgenerally
meansthatthewhitebalanceisoff.Youcanusethe"AutoColour"featureto
adjustthisautomaticallyWiththe file open,click Image >Adjustments> Auto
Colour. Photoshop will try to adjust the white balance to natural levels.
Auto Contrast
Inimageswithverylittlevariationbetweenlightanddarkareastheauto-contrast feature
will either enhance or smooth out these differences to make a better picture
overall
Image>Adjustments>AutoContrast



MergeLayersandFlatten Image
MergeLayers
LayersareagreattoolthatyoucanusewhileworkingwithAdobePhotoshop,but only if
you use them the right way Too many layers can cause disorganization, increased
file size and can slow down Photoshop There is an option in Photoshop called
merge layers, which allows you to merge two or more layers together to help keep
you organized and working smoothly.
1. StartAdobePhotoshopandstarta newblankPhotoshop document
2. Createtwonewlayersinadditiontoyourbackgroundbyselectingthe"New"
option from the "Layer" menu. Then, select "New." You should now have your
background and two other layers.
3. Linkyourtwonewlayerstogetherbyclickingtheemptyboxtotherightofthe
eyeicononyourLayerspaletteforeachofthelayers.Youshouldseeachainlink appear
in the empty boxes. The layers are linked together now. If you move one layer,
the other layer will now move along with it
4. Merge the two layers together by selecting the "Layer" menu and then "Merge
Layers."Thetwolayersarenowmergedtogether.Youshouldnoticethetwolayers are
just one layer in the Layers palette.
Flatten Image Adobe Photoshop creates layers when working with an image. You
can use these layers to manage and enhance the image by changing the
background,highlightingportionsoftheimageorcombiningtwoimagestocreate a new
one. When the project is complete, flatten the image to combine all the changes
into one image; this reduces the overall file size. Fortunately, Photoshop makes
this an easy process
1. Saveyouroriginalimage.Alwayssaveyouroriginalimagesothatyoucanuseit again
later.
2. OpentheLayerspalette,Ifit'snotalreadyopen,byclicking"Windows"onthe menu
bar at the top of the screen. Scroll down and select "Layers”
3. Clickon"Layer"inthemenuatthe topofthe pageScrolldownandselect
"FlattenImage”Allthelayerswillcombineintoonelayer.Alternatively,clickonthe
symbol in the top right corner of the Layers palette and select "Flatten Image” In
Photoshop CS, the symbol looks like a white circle with a right-pointing arrow; in
other versions, like a down-arrow with five lines next to it.
4. Savetheimageasa JPEG,BMP,PNG,EPS,GIForanyotherformat,dependingon your
preference Difference
FlattenimageflattensalllayersintoaflatimagefileandMergelayersallowsyouto select
certain layers and only merges them, leaving the other layers intact.



BlandingModesinAdobePhotoshop
Blend modes in digital image editing are used to determine how two Layers are
blended (Mix) into each other. The default blend mode in most applications is
simply to hide the lower layer with whatever is present in the top layer. However,
aseachpixelhasanumericalrepresentation,alargenumberofwaystoblendtwo layers is
possible Note that the top layer is not necessarily called a "layer" in the application
It may be applied with a painting or editing tool. There is different blending mode
available in Photoshop
Basic Modes
1. Normal:
Normaleditsorpaintseachpixeltomakeittheresultcolour.Basically,wearen’t getting
any kind of effect here since both of our images are fully opaque. We’re just
seeing the image on the upper layer. This is the default mode for every new layer.
2. Dissolve:
The dissolve mode takes random pixels from both layers. With high opacity, most
pixels are taken from the top layer. With low opacity most pixels are taken from
thebottomlayer.Noantialiasingisusedwiththisblendmode,sothepicturesmay look
grainy and harsh.
3. Screen:
With Screen blend mode the values of the pixels in the two layers are negated,
multiplied,andthennegatedagain.Thisisinsomeway theoppositeofmultiply. The
result is a brighter picture
4. 0verlay:
Overlay combines multiply and Screen blend modes. Light parts of the picture
becomelighteranddarkpartsbecomedarker.Anoverlaywiththesamepicture looks like
an S-curve.
5. SoftLight:
ThisisasofterversionofOverlay.Applyingpureblackorwhitedoesnotresultin pure
black or
6. Hard Light:
HardLightcombinesmultiplyandScreenblendmodes.EquivalenttoOverlay,but with
the bottom and top images swapped Divide this blend mode simply divides pixel
values of one layer with the other.
7. Addition:
Thisblendmodesimplyaddspixelvaluesofonelayerwiththeother.Incaseof values
above 255 (in the case of RGB), white is displayed



8. Subtract:
Thisblendmodesimplysubtractspixelvaluesofonelayerwiththeother.Incase of
negative values, black is displayed
9. Difference:
Difference subtracts the top layer from the bottom layer or the other way round,
to always get a positive value. Blending with black produces no change, as values
forallcoloursare0.(TheRGBvalueforblackis0,0,0)Blendingwithwhiteinverts the
picture
One of the main utilities for this is during the editing process, when it can be used
toverifyalignmentofpictureswithsimilar content.Exclusionisaverysimilarblend mode
with lower contrast.
10. Darken:
OnlyDarkentakesthedarkestvalue foreachpixelfrom eachlayer.
11. Lighten:
Onlylightentakesthelightestpixelfromeachlayer.
12. Colour:
Colour creates a result colour with the luminance of the base colour and the hue
andsaturationoftheblendcolour.Thispreservesthegraylevelsintheimageand is
useful for colouring monochrome images and for tinting colour images.
13. Luminosity:
Luminositycreatesaresultcolourwiththehueandsaturationofthebasecolour and the
luminance of the blend colour. This mode creates the inverse effect of Colour
mode.

SavingImagesfortheWebinAdobePhotoshop?
The internet is probably one of the largest mediums for distributing art, graphics,
and photographs nowadays, making it very important to have some basic
knowledge on saving media for the web. Essentially, saving for the web is a
balancing act. You must balance the quality of the graphic and the file size of the
media to suit your personal needs. In a place where speed is important, you may
need to sacrifice some quality of a graphic. Where quality is important, you may
needtosacrificesomespeed.Thislessonaimstoshowyouwaysinwhichyoucan balance
these two factors, and at the same time produce terrific image quality Process of
saving the image for web
AdobePhotoshophasagreatwaytooptimizeimagesfortheweb.InPhotoshop, go to
File > Save For Web, or click Ctrl+Alt + Shift + S
Anewboxwillpopupwithallofthesettingsfor savingandoptimizinganimage for the
web:



1. Chooseafileformat
2. Chooseanimagesizeatwhichtosave yourimage
3. Choosea qualitylevelforjpgornumberofcoloursforgif
4. Choosealocationforyourfileonyourdrive.
IfyouwanttomaketransparentpicturethenselecttransparentchekboxON.And
selectgiffileformat.The usualpreferred filetype ofphotographsisJPEG,whichis
named after its creators, the "Joint Photographic Experts Group" Changing
Measurement Unit and Ruler in Photoshop
Doone ofthe following:
1. Double-clickaruler.
2. ORChooseEdit>Preferences>Units&Rulers,orright-clicktherulerandthen choose
a new unit from the context menu.
3. ForRulers,chooseaunitof measurement
4. Note:ChangingtheunitsontheInfopanelautomaticallychangestheunitson the
rulers.
5. ForPoint/PicaSize,choosefromthefollowing options
6. Postscript(72pointsperinch)Setsaunitsizecompatibleforprintingtoa
Postscript device.
7. TraditionalUses72.27pointsperinch,astraditionallyusedin printing
8. Click OK

CreateSwatchesinPhotoshop
Ifyouhaveanimagewiththecoloursyouwanttouse,youcanusetheeyedropper tool to
select colours from your image, then add them to the swatch palette and make a
custom swatch collection one colour at a time. If that sounds time consuming to
you, you'll be glad to know that you can create a custom swatch collection from
the colours in an existing image. The following process creates the custom colour
switches.
1. Opentheimage,whichhavesomecolourinPhotoshop.Makeacopychoose
Image > Duplicate
2. To reduce the number of colours in the image down to 256, choose Image >
Mode > Indexed. If your image is in CMYK mode, you'll need to convert it to RGB
andthenIndexed.Adialogboxopensupwithoptionsforconvertingyourimageto
Indexed Colour. Choose Local (Perceptual) in the Palette drop down box.
3. NowchooseImage>Mode>ColourTabletoviewitandthecoloursselected from
your image
4. NowyoucansavethetableclickonSavebuttonontheColourTabledialogbox and
then save it Into Photoshop > Presets > Colour Swatches folder.



5. To load up your palette with your new swatches, open the Swatchespalette and
from the drop down menu in the top right corner choose Replace Swatches.
Browse to the folder where you saved your colour table and open up the new
palette.Palettescanbesavedas.ASE,.ACTor.ACOsomakesureyouaresearching for the
file format that you saved you swatches in.

CreateaCustomBrushin Photoshop
InAdobePhotoshoptherearemanytypeofpresetbrushandtheresizesbutadobe also
provide a facility that we create our own custom type of brush. The following
procedure is used for this purpose.
1. Firstofall createanewdocument.
2. NowselecttheBrushToolfromtheToolspalette
3. SelectanypresetbrushforexampleSmallRoundBrush.
4. Makesurethe foregroundcolourissettoblack.
5. Nowpaintthebrushstrokesinside thedocument(inthatwaywhichtypeof brush
you want).
6. Nowclick onEditmenuandchooseDefineBrushPreset
7. Innextstep givethe nametobrushandclick on ok.
8. Newbrushisnowcreatedandaddedinthebrushlist
9. Youcanselectyouowncustomtype andthenuse it.

CreateanActioninPhotoshop
When we perform some set of instruction in Photoshop again and again in same
way then this is the best way that we create an action store the set of instruction
andcallbackwhenyouneed.Inaction thestepyouperformrecordedandwecan use
these step again by pressing one single key in future. Now we discuss how an
Action is created in Photoshop
Proceedfollowingstepsonebyone
1. Openafilein Photoshop
2. ClickonactionTabinHistory Panes.
3. AtthetoprightoftheActionsboxorpalette,thereisanarrow.Clickhereto open
more options and select New Action.
4. NameyourActionandassignaFunctionKey
5. Yourrecordingwillstartyoucanstoprecordingbyclickingonstopbuttonin Action
panes
6. Now perform some steps. I am going to set the brightness of my image after
settingthebrightnessclickonstopbutton(youcanperformanysetofinstruction)
7. Howweuse TheseAction



8. Nowclose everythinganddon'tsave thisimage.
9. OpenagainthisimageinpreviousconditionandclickonactionformHistory Panes.
10. Selectyouractionfromlistandclickonplaybutton(youcanalsopressyou
function key which you specify at the time of recording.)
11. Youcanseethebrightnessofyourimageautomaticallyadjust.
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